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1  INTRODUCTION
This document is user manual for XSite PRO machine control system (“Product”). Read this  
manual carefully before any use of the product and especially observe the safety instructions. 
Make sure that you understand the information contained in this manual before any use of the 
product. Keep manual available for later use.

System software version
This manual applies to software version SPI 14.2

Manufacturer's contact information
Novatron Oy
Jasperintie 312
33960 Pirkkala, Finland
Tel: +358 (0)3-357 26 00
E-mail: sales@novatron.fi, service@novatron.fi, techsupport@novatron.fi
Web: www.novatron.fi

Conformity to FCC rules (North America)
This product complies with part 15 of the FCC rules.

Disclaimer
The manufacturer does not accept any liability for damages caused by:

 Inappropriate assembly and/or installation
 Non-observance of the User Manual
 Non-intended and improper use
 Use beyond operation limits
 Use by insufficiently qualified and trained personnel
 Use of unauthorized spare parts and accessories
 Deconstructing and/or rebuilding of the product

Conformity to directives and regulations
This product is in conformity with EU's EMC (2004/108/EC), RED (2014/53/EU),  RoHS 
(2002/95/EC), and WEEE (2002/96/EC) directives and REACH (2006/1907/EC) regulation.

This product may not be disposed of together with unsorted household waste, it must be collected 
separately.

The product contains radio modem manufactured by Sierra Wireless.
• Sierra Wireless MC7710 or MC7304 modem (European Union)
• Sierra Wireless MC7330 modem (Eastern Asia)

Modem is used for communicating in the following networks: GSM, GPRS, EDGE, WCDMA, 
HSPA, HSUPA.

EU declaration of conformity for the radio modem is available at:
Sierra Wireless (UK), Limited
Lakeside House
1 Furzeground Way, Stockley Park East
Uxbridge, Middlesex
UB11 1BD
England
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Disclaimer
The manufacturer does not accept any liability and makes no warranty and representation (either 
implied or express) of the accuracy or completeness of the information contained in this document.
The manufacturer is not liable in any circumstances for any possible loss of profit or revenue or 
other financial loss, including but not limited to any special, incidental, indirect or other damages. 
Furthermore, the manufacturer reserves the right to correct and change the contents of this 
document from time to time, without any obligation to inform any person of such corrections and 
changes. 

The product shall be only used for the purpose determined in this document, and only together with
such devices and parts that the manufacturer has accepted or which it recommends. The 
manufacturer does not warrant fitness for any particular purpose. Correct and reliable functioning 
of the machine requires appropriate transport, storage and installation, as well as cautious use and
repair.

The manufacturer does not accept any liability for any damages caused by:

• Inappropriate assembly and/or installation
• Non-observance of the User Manual
• Non-intended and improper use
• Use beyond operation limits
• Use by insufficiently qualified and trained personnel
• Use of unauthorized spare parts and accessories
• Deconstructing and/or rebuilding of the product, or
• any other similar matters for which the operator is responsible for

User Manual

The Manual contains basic information to be considered when using and maintaining the product. 
Observing all security instructions and guidelines given here is important for safe operation. 
Therefore this operator Manual must be read prior to any use of the product and applied without 
fail by any person assigned with working processes at the machine, such as operation, diagnostics
and maintenance.

The Manual is a part of the product and must be passed on to third persons or later owners as 
required. It must be permanently kept at the usage site and be available for operating and 
maintenance personnel. All local accident prevention regulations, general safety regulations and 
the manufacturer’s safety regulations must be observed by the operator.

The product is available with various sensor combinations. If your system is not equipped with all 
sensors or other components, their description and instructions do not apply. Due to multiple 
possible applications, the functions of the product in this manual will be explained by an excavator 
installation manual.

It is the intention of the manufacturer that the Manual remains correct and up-to-date. To ensure 
that we keep our technological advantage it may be necessary to undertake modifications of the 
product and its operation without prior notice; in such cases the information in this manual may be 
superseded by further revisions, and your local dealer will provide you with a new manual upon 
your request. The manufacturer and its representatives do not accept liability for any disturbances, 
failures or resulting damages.

We will not be held liable for possible errors or consequences arising from this manual. Should you
wish to make suggestions regarding this manual or point out possible errors, please contact your 
local dealer. We will gladly take your ideas and suggestions into consideration.
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Explanation of the symbols

Notices are marked with symbols in the Manual. Observe these notices at all times and proceed 
carefully to prevent accidents, personal injury, and material damage.

Indicates a hazardous situation. If not avoided, could result in death, serious injury, or
material damages.

Note!
Emphasizes useful tips and recommendations as well as information referring 
efficient and failure-free operation.
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1.1  Safety instructions
This chapter outlines important safety matters concerning the operating procedures necessary for 
ensuring optimal personnel safety. It is important that these instructions are followed because they 
enable users to recognize and prevent potential operating risks before they occur. All users must 
understand and observe these instructions prior to any use of the product.

When operating machine the operator must not solely trust the operation of the 
product. Operating machine solely based on the product is forbidden. The operator 
must observe the usage site in order to avoid risks.

Conventional use

The product has been exclusively designed and constructed for conventional use as described 
here:

• Positioning the tool of a construction machine
• Indicating the position of a measuring point to the operator
• Comparing the position of a measuring point with reference informationn

Any other use not listed here, as well as any application not complying with the technical data, is 
not considered conventional use. The manufacturer is not liable for any damages or consequences
caused by any improper or unauthorised use of the product.

Improper use
The following situations, without any limitations, are considered improper use of the product

• Non-conventional use
• Exceeding the limit values given in the manual
• Use of the product without instructions
• Use of the product beyond the limits of use
• Using the product with safety equipment disabled
• Removal of labels on the product (for example, warning labels)
• Opening, taking apart, rebuilding or making alterations to the product
• Using the product in spite of obvious defects or damage
• Using the product with unauthorised accessories, devices or services from other 

manufacturers
• Using the product at insufficiently secured construction sites

Alteration and rebuilding of the product
To prevent risks and ensure optimal performance, rebuilding or making any alterations to the 
product may not be carried out without the manufacturer’s explicit prior permission. The 
manufacturer's explicit permission is also required before adding any attachments or notices to the 
product.

The operator’s responsibility
The product is used in the industrial sector. Therefore, the operator of the product is liable to the 
legal responsibilities for operational safety. Besides the operational safety instructions in this 
manual, the safety, accident prevention, and environmental protection regulations valid for the 
operational area of the product have to be observed by the operator
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• The operator has to inform himself about the current operational safety regulations and, in a
risk assessment, detect additional risks that are caused by the special working conditions at
the usage site of the product. The operator must then implement these in the form of 
directives. These directives have to be kept near to the product and permanently be 
available for the persons working with it.

Particularly applying for the operator, without any limitations:
• The operator has to clearly define the personnel’s responsibilities referring the appliance.

• The operator has to ensure that the operator Manual’s content is fully understood by the 
operating personnel prior to any use of the product. The operating personnel must adhere 
to User Manual at all times when using the product.

• The statements of the User Manual have to be observed thoroughly and unrestrictedly.

• The operator has to ensure that all maintenance, inspection and assembling processes are 
carried out by qualified specialized personnel, which have informed themselves sufficiently 
by closely studying and understanding the manuals for the product’s operation.

• The operator informs the manufacturer or the authorized dealer without any delay if any 
safety defects occur at the product or during operation.

Special risks

Epilepsy warning

Some people are susceptible to epileptic seizures or loss of consciousness when 
exposed to certain flashing lights or light patterns. Immediately discontinue use and 
consult your doctor if any of the following symptoms occur while using the product: 
dizziness, blurred vision, eye or muscle twitches, loss of consciousness, disorientation 
or any involuntary movement or convulsion.

Risks caused by electric current

When working close to electric systems (, for example, overhead powerlines), there is 
danger to life due to electric shock. Keep sufficient safety distance to electric systems.

Moving components

Keep persons away from the machine’s and the tool’s working range. Remove objects 
from the machine’s and the tool’s working range. Do not interfere with the moving 
components during operation.

Overlapping machine parts

Subsequently assembled system components (, for example, GNSS masts) can 
overlap the typical machine dimensions. This can lead to injuries and material 
damages.
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Risk of injury caused by malfunction

Uncontrolled machine actions caused by the malfunction of a system component can 
lead to severe personal injuries in the machine’s working range or cause material 
damage. Ensure that the machine is operated, controlled and inspected by a qualified 
and experienced operator, who has to be able to induce emergency measures, for 
example, an emergency stop.

Lacking instruction

Lacking or insufficient instruction can lead to operating errors or incorrect use. This can 
lead to severe personal injuries as well as severe material and environmental 
damages. Observe the manufacturer’s safety instructions and the operator’s directives.

Risk of injury caused by insufficient safeguarding

Insufficient safeguarding of the construction site and the component’s location, for 
example, of the laser emitter, can lead to hazardous situations in traffic and at the 
construction site. Ensure sufficient safeguarding of the construction site. Ensure 
sufficient safeguarding of the single components’ locations. Observe the country-
specific safety and accident prevention regulations as well as the current road traffic 
regulations.

Risks caused by faulty measurement results

Faulty measurement results due to use of a dropped product, another illegitimate 
demand or an alteration can lead to severe material damages. Do not use obviously 
damaged products. Before reusing a dropped component, carry out a check 
measurement.

Risk of injury caused by unreadable signs

In the course of time, labels and symbols on the product can get dirty or get 
unrecognizable due to other events. Due to immoderate mechanical effects labels and 
symbols can be detached. Always keep safety, warning and operation instructions in a 
well readable state. Regularly check the adhesiveness of the labels and symbols on the
product. Do not remove labels and symbols from the product.

Risk of injury caused by inappropriate disposal of the product

When burning plastic parts, toxic gases that can cause illnesses emerge. Dispose the 
product properly according to the current national country-specific disposal regulations. 
Careless disposal might also enable unauthorized persons to improperly use the 
product. In doing so these persons and/or third persons can be severely injured and 
also pollute the environment. At all times, protect the product against the access of 
unauthorized persons.
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Accidents and Emergencies

Preventive measures

• Always be prepared for possible accidents or fire
• Keep a first aid kit within reach
• Familiarise all personnel with the location and use of first-aid equipment, accident 

notification procedures and procedures for alerting the emergency services
• Keep access routes clear for emergency vehicles

In the event of an accident, proceed appropriately:

• Shut down the equipment immediately by switching the power off
• Begin first aid measures
• Move persons out of the hazard zone
• Inform the manager of the job site
• Alert medical assistance and/or the fire brigade
• Ensure that access routes are clear for emergency vehicles
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1.2  Product overview
Xsite PRO is a machine control system for construction machines. Xsite PRO indicates the position
of the measuring point (for example, measuring point of the bucket’s blade) compared to a 
reference level. The system can be used as a 2D (Vision) or 3D system (LandNova).

The system can be used in the following construction machines:

• Excavator
• Wheel loader (Machine model is different and bucket calibration is horizontal not vertical 

plumbline calibration)

The system contains the following components by default:

• Computer unit (MCC15)
• Display unit (Xsite PRO display)
• Gravitation sensors (G2 sensors)

• Number of sensors depends on type and model of the machine
• Excavator system contains at least bucket, stick, boom, and frame sensors
• Wheel loader contains at least bucket, boom and frame sensors

The system can be expanded by the following optional accessories:

• Tilt bucket sensor
• Dual block boom sensor
• Laser receiver (EL2 not used with wheel loader)
• XD2 LED display
• GNSS equipment
• Radio modem

Fig. 1. System diagram
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1.3  Handling of the system

The display cable must not be connected or disconnected when the system power is 
on. The cable must be connected properly before switching on the system. Incorrect 
use of the display cable may cause damage to the display or to the computer. See 
section 2.1 “Connecting the display” for more information.

The display unit is not waterproof. If the display or other components are taken away from the 
construction machine for any reason, a carrying case should be used. Make sure that the 
components are clean and dry before placing them in the carrying case. Also make sure that the 
carrying case is clean and dry.

Fingerprints and other dirt can be removed from the display with a soft, lint-free cloth. A cleaning 
liquid can also be used with the cloth. Dampen the cloth with isopropyl alcohol, water or a mixture 
of alcohol and water and clean the display. Do not spray the cleaning liquid directly on the screen. 
Do not use any corrosive chemicals on the screen.

3D features of the system require a license key which is connected to the system. The operator of 
the system is responsible for storing the license key.

Note!
If the 3D license key is lost, a new one must be purchased from the local dealer.
License key is located inside of the MCC 15 computer unit.

1.4  Transportation and storage
When transporting the equipment to the usage site or carrying it in the field, always ensure that the
product is transported in suitable, secure containers. Never transport the product loosely in a 
vehicle; knocks and bumps can severely harm the functioning of the product. In case of 
transportation by railway, plane or ship, always use the original packaging, transport containers 
and transport boxes. The packaging protects the product from bumps and vibration.

Store the product in a well-ventilated dry place. During storage, protect it against moisture. Use the
original packaging whenever possible. Avoid extensive temperature changes during storage.

Water condensation can form gradually and may harm the functioning of the product.

1.5  Support and maintenance
Maintenance services are provided by the manufacturer or the authorised dealer. The installation 
and servicing of the product should only be carried out by trained and qualified personnel.

All settings are stored onto the internal memory device, which is backed up by the fitter after the 
installation. If any problems occur with the installation settings, a recovery can be made.

Only representatives of the manufacturer are allowed to open the product housings.

Remote support provides instant help desk services for machine operators (see section 7 ”Network
operation”).
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2  GETTING STARTED
This section provides information about the system hardware and the user interface.

2.1  Connecting the display
Don’t strain or kink the cable while connecting or disconnecting the cable. Avoiding sharp bends in 
the cable will keep your cable working longer. The display cable must be connected before 
switching on the power to the construction machine. The display cable is connected to the 
connector on the back of the display (Fig. 2). The cable is connected by pushing the connector and
is disconnected by pulling from the connector housing. 

Be sure to visually check that the cable is properly connected. An improper connection may cause 
damage to the display unit or to the computer. The cable must not be connected or disconnected 
while the system power is on because it may cause hardware damage (Fig. 3).

Fig. 2. Back of the display unit

(1) Display cable with connector 

(2) RAM mount

Fig. 3. Improper (left) and proper (right) connections 

Make sure that the system is powered off when you connect or disconnect the cable. 
Make sure that the cable is properly connected before turning on the system.

When the cable is connected, the display can be mounted with the RAM mount bracket to a 
suitable viewing angle. Mount the display so it blocks the view as little as possible.
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2.2  Turning on the system

To help protect system memory and prevent possible data loss when first starting the 
machine, it is recommended to start the machine first and then turn the system on. It 
is not necessary to turn the system off before restarting a warm machine. This 
situation may occur, for example, when restarting from an auto idle shutdown 
condition. 

The system is turned on by pressing the power button on the display (Fig. 6). After one 
second, the red back lights of the buttons will turn on. When the red lights have been on 
for approximately 15 seconds the light will turn yellow. It takes approximately one minute 
for the operating system to start up.

Sensors are equipped with an internal heating system. When a machine is used below 0°C (32F) 
temperatures, it will take time for the sensors to warm up and provide accurate results. The 
recommended amount of time needed between turning the system ON and starting work is shown 
in Table 1 below. Users should allow for the proper warm-up time in order to ensure accurate 
measurement results.

Table 1. Recommended warm-up time.

Temperature Warm up time

-20°C Approx. 20 min

-10°C Approx. 10 min

-5°C Approx. 5 min

2.3  Installing or changing a SIM card
For network services and getting RTK correction a SIM card is needed. SIM card is installed to 
MCC15 computer unit, see Fig. 4.

To insert or change a SIM card:

1. Make sure that the system is powered off
2. Open plastic dust lid labelled as “SIM”
3. Press yellow tab to get tray out
4. Place SIM card to the tray
5. Close the tray. Card installation is now completed

Fig. 4. Inserting a SIM card in to the MCC15 computer unit.
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2.4  Display unit, USB ports and buttons
The system works via touch screen (Fig. 6). In addition to touch screen, there are separate buttons
for brightness adjustment and a mute. 

Connectors: There are two USB connectors (Fig 5) at the bottom of the display unit that can be 
used.

Fig. 6. Display unit

Touch screen (display)

Reduce brightness

Increase brightness

Power on/off

Mute

2.5  Turning off the system
Press shortly power button and select “Shutdown”.

The system can be turned off by pressing from start window.

If you need to continue working with 2D application the LandNova can be closed by selecting 
“Project”  → “Back to 2D or Exit”.

If a shut down cannot be carried out, for example, the system does not turn off after the ”Shut 
down” button on the touch screen has been pressed, forced shut down can be accomplished by 
pressing and holding the ”Power” button down for 30 seconds.

Avoid forced shutdown, it may damage the internal storage media and cause data 
loss. Contact local service personnel before use forced shutdown.
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3  USING THE 2D SOFTWARE
The 2D application is named as “Vision”. When using the 2D system the height reference can be 
taken from laser reference (optional laser received is needed) or a stake (any physical height 
reference can be used). System can measure height and distance. Height reference have to be 
taken again when machine is relocated.  

3.1  Getting started
When the Vision is started the Main menu is shown as in Fig. 8 below. To starting work with 2D, 
press “Start” button 1.

Selections from the Main menu of the Vision (fig 8):
(1) Start opens “2D work view” as seen in the fig. 7

◦ “Measurement / work view”

(2) Language opens language selection

◦ Language of 2D software user interface can be changed.

(3) Settings opens 2D software settings

◦ For example, bucket calibration (measurements and plumbline calibration)

3.2  Measurement / work view 
The fig. 7 displays software's measurement / work view. It can be used, for example, to measure 
depth, distance and slope. Operator can see measurements results and change view angles.

To begin work select Main menu → “Start”
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3.2.1  Symbols (icons) on the display while working
At “work view” the symbols are seen on top of the display (Fig. 7).

Height. See section 3.4
When height icon is pressed, the height readout is zeroed or set to a predefined value 

Distance. See section 3.5
When distance icon is pressed, the distance readout is zeroed or set to a predefined 
value 

Slope Slope: Edit slope by clicking Slope  See section 3.7

B1..B10 Identifier of the chosen bucket (B1, B2 ...) Change bucket by clicking B1..B10  

Side view of the bucket: 
• The view from the side of the bucket
• Zoom in / out by using the + and - icons

Front view of the bucket: 
• The view from the front of the bucket
• Zoom in / out by using the + and - icons

Free view
• A freely adjustable view
• Zoom in / out by using the + and - icons
• Rotate by moving a finger on the screen

Change measuring point of a bucket
• Left
• Middle
• Right
• Automatic (Measuring from the lowest point of the buckets blade)

Orient machine with model (Used only with slopes)
• +Y (270 deg)
• -Y    (90 deg)
• +X     (0 deg)
• -Y  (180 deg)

Start LandNova (The 3D application)

 Zoom view in

 Zoom view out
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3.2.2  Basic operations / buttons on the display
In work/measurement mode an operator can perform basic operations using buttons from the lower
part of the display (Fig 7). 

Button Action

Start depth
and 

distance

Reset depth and distance readouts (Zero or set to both readings to predefined 
values). 

More information:
“Depth settings”:  section 3.4
“Distance settings”. section 3.5

Start slope

Slope (Simple in fig. 10 / Advanced in fig. 9) 

• Sets the depth reading and bucket tip to the start of the slope.
• Slope and depth values have to be defined before starting work.
• Profile is visualized on display (See fig 11, red line)

More information in 3.7

Memory

Memory function

It is used for keeping height reference when relocating the excavator.

For more information in 3.6

Menu
Various settings (set slope, cut depth, alerts).

See  “Settings” 3.3

Return to the Main menu, see Fig 8.

Fig. 11. “Start slope” is selected, view  “Side view” is selected (green circle.)
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3.3  Settings
Enter to the settings:

 Start screen → “Start” → “Menu”

(1) GPS (opens menu where you can
start or stop LandNova 3D software)

Depth and distance settings

(2) Set cut depth / set start depth / Use
laser as reference

See section “Depth settings” 3.4

(3) Laser ON / OFF
Set laser receiver on or off

(4) Set distance / Set start distance 
Set start distance. See section
“Distance settings” 3.5

Slope settings

(5) Set slopes 
See section  “Slope measurement”

Movement limits

(6) Set limits
Warning levels can be set. The system will alert the operator if the bucket or boom crosses the 
warning levels. See section “Restriction of movements” 3.9.2. 

Alert limits

(7) Tone and led settings
See section “Alert limits” 3.9.1

(8) Reset 
Reset all settings to factory defaults.

(9) Volume 
Increase / decrease the volume of the system.
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3.4  Excavation using a reference height (stake)
To excavate using a reference height (for example, a stake), select: 

“Main menu” → “Start” → “Menu” → “Set cut depth / Set start depth”

Note that “Use laser as reference” should not be checked when the stake is used as reference.

Example: Reference (stake) is at 30.0 metres and target depth is 28.2 m (1.8 m will be removed). 
(1) Set target (cut) depth to 28.2  and press  OK   (see the below fig 13 and 12)

(2) Set laser/start depth to 30 and press   OK  

(3) Return to the “working / measuring mode” press   ←  
(4) Bring bucket to the reference and press icon to set start depth (Fig 14).

• Pressing “Start depth and distance” (yellow circle fig 14) will reset both depth and 
distance to predefined values.

(5) Verify that start depth is 30 meter (reading inside the green circle at the (Fig 14)

(6) Start and continue excavating until bucket is level with horizontal red (or green) line (Fig 15)

(7) Target depth is reached at 28.2m (30m - 1.8m)

Readout (big green circle in Fig. 14) indicates the height of the bucket. The red (or green) 
horizontal line shows target level (depth). Here the target is 1.8 metres below start depth.

When height icon is pressed, only depth reading is set to predefined “laser/start depth” 
value.
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Fig. 16. Target depth reached at 28.2m.

Fig. 15  Target depth is reached at 28.2 metres

Fig. 14. Readout at stake after reference is set



3.5  Distance measurement while working
To set distance, select “Menu” →”Set distance / Set start distance”. To set depth Menu” → “Set cut 
depth / Set start depth”. 

Example of making a ditch: 

Excavate 2 metres long ditch from a reference point (stake) towards a machine (Fig 17)

1. Set starting distance to zero (0) (Fig. 18), if ditch starts nearer machine than stake, enter 
starting distance as negative value (distance between the stake and beginning of the ditch)

2. Return back to the measurement / working, press   ←  

3. Bring bucket to the reference (stake) and press  |→  icon to set reference (Fig 18). 
Pressing “Start depth and distance” will reset both depth and distance to predefined values.

4. Verify that the starting distance is zero or entered distance value 
when bucket is at the stake. (zero in this example)

5. Start and continue working until distance is reached (2m in our example. Fig 18)

• Reading increases when excavating towards machine.

Fig. ￹￹18   Distance values

If distance icon is pressed, only distance reading is resetted to the predefined “Set starting 
distance” value.

The depth of the ditch can be set up: Menu” → “Set cut depth / Set start depth”, so depth and 
distance both can be measured and monitored while working.

Note!
Instead using distance and depth measurements to creating a ditch, using advanced 
slope for ditch may be more practical tool. See 3.7
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Fig. 17   Starting distance

Fig. ￹￹ 19. Target distance / distance reading when target is reached



3.6  Relocating the excavator by using the memory function
The excavator can be moved to another position by using the memory function. To move excavator
you need an extra reference point, for example a stable rock.

Verify the depth

Select from the Start screen → “Start”. Depth is measured using a reference (see Fig.20).

1. Create a memory point

The memory point must be accessible from a new location. 
Before moving the machine, choose a stable memory point. For example, a good reference is a 
big rock (see fig. 21).  Bring the blade of the bucket to a memory point and press the ”Memory” 
button and memory point is created.

Fig. 21. Create a memory point by pressing the memory button, step 1/2

2. Use a memory point

After relocating the machine (see Fig. 22), bring the blade of bucket to the memory point 
(created at step 1) and press ”Memory” button again.

Fig. 22. Take in use the created memory point (height), step 2/2
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Fig. 20. Verify depth



Continue digging from new location

The system measures a depth compared to the original reference point (stake), even though 
machine position and altitude has been changed (see fig. 23).

Fig. 23. Digging continues after relocating the machine

Warning: Every relocation of the machine degrade the precision whenever a new reference point
is created. 
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3.7  Creating an advanced or simple slope using the system
Set slopes: Select: Start screen → “Start” → “Menu” → “Set slopes”

Select slope type:

• A) Simple slope 
◦ Enter slope value for X (usually slope is made only one direction so Y is set to zero)

• B) Advanced slope (Fig 24)
◦ Enter values for each field. (usually slope is made only one direction so Y is set to 

zero )
• Return to the “work view”
• It is recommended to use “free view” mode, marked with green circle below (Fig 24b).
• Press “Start slope”

Fig. 24.  Advanced slope tool, setting value              b) view while working, freeview selected

An advanced slope is created by setting the length and slope values for each section. Four 
individual sections can be defined.  

Work view explained (figure in right):

• Red line shows X axis
• Green shows Y axis, blade of the

bucket
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3.8  Working with a Laser reference (with or without the stake)
Laser receiver is optional and is needed when working with rotating laser. A rotating laser has to be
set to same angle as desired plane/slope.

Using a rotating or scanning laser allows to relocate a machine quite freely. Operator can easily 
continue working after excavator is moved to another position. Height reference can be taken to 
the system from a laser beam. Reference is taken by moving the boom (laser receiver) to the laser 
beam. 

Laser and stake can be used together. Actual height reference is taken from the stake and laser 
beam just allows excavator to be moved away from the stake. The laser assist the system to keep 
track to the height reference. Rotating laser can be set at any altitude (pay attention to visibility of 
the laser beam at a jobsite).  

When stake is used with the laser, the option  “Use laser as reference” must be disabled (not 
checked).  Menu → “Set cut depth” → “Use laser as reference”

When the laser is used (without a stake) as height reference, the
option “Use laser as reference” must be enabled (checked).

Move the boom until the laser beam hits the laser receiver. The laser receiver icon indicates that 
the receiver has hit. The green signal light (with a sound) indicates that the hit has been accepted. 
The laser receiver will accept the beam when the stick is ±60 degrees from the vertical line.

Using stake as reference with laser assistance 

1. Bring laser receiver to  beam, system gives audible note with visualization. 
2. Place measurement point of the bucket to the stake
3. Press “Start depth and distance”
4. System use the stake as a height reference
5. If excavator’s altitude is changed bring the receiver to the beam again.
6. You can continue working using the original stake’s height reference.

Fig. 25. Using the laser receiver to maintain stake’s height reference.

Note!
If the height of the machine is changed, bring laser receiver to the laser beam to get 
correct height reference. Height reference is valid until height of the machine is 
altered. A rotating laser has to be set to same angle as desired plane/slope.
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Place measurement point of the bucket to the stake.

Fig. 26. Measuring depth, reference is taken from a stake (or from another reference)

If excavator’s altitude is changed bring the receiver to the beam again.

Fig. 27. Move the boom to the laser beam until audible note is given

In this example the target (cut) depth has been set to 1.80 m below “start depth”. 
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3.8.1  Automatic height update to a laser reference while working
When the “Use laser as reference” has been enabled and laser beam hits once to the receiver, 
system shows height of the measuring point of the bucket. If an altitude of the machine changes, 
bring the laser receiver to the beam again (Fig 28). 

Using laser reference without a stake:

1. Enter “Set laser/start depth” same as jobsite laser height (in this example 90.0 metres)

2. Enter “Set target depth” (in this example 87.0 metres)

3. Select (tick):  Menu → Set target depth → “Use laser as reference”

4. Continue excavating until target level is reached (horizontal red line on the display can be 
seen)

• In this example the target height is 87.0 metres (90.0 m – 3.0 m)

 

Fig. 28. Moving the receiver to the laser beam (height reference is fed in to the system)

Fig. 29. Measure depth using the measurement point of the bucket.
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3.9  Special settings

3.9.1  Alert limits and XD2 LED display
Select: Start Screen → Start → Menu → “Tone and led settings”

The symbols with an audible signal assist the operator at work. Alert tolerances are adjustable. 
operator can adjust levels for all levels (Level1 defines tolerance for “Ongrade” so there is the 
same tolerance below grade and above grade). 

Colour of the XD2 level indicator (Fig. 31)

Colour Height (Tolerance settings see Fig. 30)

Yellow Above on grade level (Level 2 setting)

Blue Above on grade level (Level 1 setting)

Green On grade 

Red Below grade (Level 1 setting)
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Fig. 30. Tone, tolerances and led settings

Fig. 31 Optional XD2 level indicator



3.9.2  Warning limits for boom movements
Set limits (audible warnings) for boom movements.

Select from the Main menu → Start → Menu →“Set limits”

Move booms to wanted position and press Set button 1, 2, 3 or 5.

The system measures height and distance of boom pins, not from the highest point 
of the boom. The system does not prevent the movement, it only gives a warning.

Fig. 32  Warning limits for boom movements 

Explanations for the buttons:

(1) Set distance limit 1
(2) Set height limit
(3) Set low limit
(4) Reset limits
(5) Set distance limit 2
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3.10  Worn or new Bucket calibration 
If the bucket is worn badly (accurate measuring is not possible) it should be recalibrated. Ten 
individual buckets can be calibrated.

To calibrate bucket: 

Select: Start screen → Settings → “Bucket calibration”.

Enter measurements:

1. Choose the bucket to be calibrated (Use “  <   >   ”) ( yellow rectangle in Fig 34)

2. Measure the length of the bucket from the lowest pin of the dipper stick to the tip of bucket. 

3. Enter length and press ”OK”. (Press “Length” value)

4. Measure the width of the bucket

5. Enter width and press ”OK”. (Press “Width” value)

6. Bucket name can be changed by pressing the “bucket name”.

Calibrate plumbline:

7. Set provided magnet with plumb on the lowest pin of the dipper stick.

8. Turn the bucket slowly towards the plumb line until it barely touches the line.

9. Press “Calibrate plumbline”

If rotator or tilting unit is installed calibration is needed (Usually done while installation):

10. Select tilt rotator communication protocol (No Roto / Engcon / SVAB / CANopen)

11. Press “Tool measures” see Fig 33 and 34

12. Enter: L15, TR1 and TR2 measurements.

• L15 is tilting axis difference from center of the lowest pin of stick

• TR1 is for visualization, rough measurement is sufficient.

• TR2 is precise measurement from rotation axes to center of lowest pin of stick. Use 
same value which was measured while installation.

13. Turn tilting axis vertically

14. Rotate tiltrotator until bucket blade is horizontal. Use spirit level

15. Press “Calibrate tiltrotator rotation”
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Fig. 33. Tool measures.
Fig. 34. Bucket calibration



3.10.1  Checking the bucket calibration
You need a reference point for checking calibration. Reference point must be stable to get reliable 
measurements.

Check calibration:

1. Place the bucket’s measurement point (blade) on a reference point (point marked with red 
in picture above) 

2. Press “Start depth and distance” button to reset the height and distance readings.

3. Turn the bucket (without tilting it sideways) to a different position (from position A to position
B) and keep bucket's measurement point on the same point.

4. Verify that the depth and distance readings are within ±1 cm compared the resetted (step 2)
values

Note!
It is important to test the accuracy of the bucket after calibration. If the accuracy is off
by more than ±1 cm, recalibrate the bucket. Double check measurements and 
perform also a plumbline calibration.
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3.10.2  Tilt bucket calibration (tilt sensor is optional)
Calibration is needed to ensure precise measurements. 

Note! Spirit level is needed in calibration. 

Calibration

1. Make sure that width of the bucket and L15 (tilting axis difference from center of the lowest 
pin of stick) values are correct (take measurements as accurate as possible).

2. Tilt axis calibration: Tilt axis
calibration is needed if tilt sensor
is installed:

• Enter to bucket calibration:
Start screen →  “Settings” →
“Bucket calibration”.

• Press the “Calibrate tilt”
button.

• Rotate the excavator until
Chassis roll value is close to
zero (green background)

• Align the red tilt axis to the
horizontal level by using the
spirit level

• Align the blade of the bucket
to the horizontal level. 

• Press “Set angle correction”.

3. Align the tilt bucket with the horizontal level by using a spirit level. 

4. Turn bucket to position A

5. Select “Automatic” (Fig 36)

6. Turn bucket slowly and smoothly from position A to position B. Continue movement with 
stick and boom until bucket cannot be turned more. 

• During the calibration, correction data is gathered from several bucket positions. Note, 
the bucket have to be moved through its whole movement area as illustrated in the Fig.
35.

• All calibration fields must have green background after calibration. Fields are 
highlighted by yellow rectangle (Fig 36).

7. After calibration is completed, unselect 
”Automatic”.

8. The calibrated bucket tilt reading must be close to
“0” degrees (blue rectangle), otherwise recalibrate
the tilt bucket. 
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Fig. 35 Turn bucket A to B



Fig. 36  Tilt bucket calibration
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4   WORKING USING POSITIONING (3D / LANDNOVA)

When using the positioning (using the 3D):

• GNSS receiver with antennas are needed
• RTK correction is needed.
• 3D project have to be imported.
• The coordinates of the bucket are known. The machine can be moved in the jobsite without

the need for physical reference points or lasers.
◦ Benefit: Physical reference points or laser transmitter are not needed.

Press “3D” icon from the Vision to start LandNova.

Hint!  LandNova can be auto started by selecting “Autostart LandNova”:

Start screen → Settings → GPS Settings → “Autostart LandNova” (Code required, contact local 
dealer)

Before starting work, the operator must check accuracy of the system. The following points have a 
significant impact on quality and accuracy of work. Procedures in the Table 2 have to be carried 
out.

Table 2. Procedures before working

Action Description

RTK correction 
connection

Establish a connection to a base station or a base station network. SIM 
card (or alternatively UHF radio) is needed for receiving RTK correction.

Coordinate system 
selection

Select the correct coordinate system and make sure that the coordinate 
offsets are correct

Geoid selection Select the correct Geoid Model or alternatively, adjust the Z coordinate 
offset

GNSS accuracy test Check the accuracy of the system on known calibration point(s).

While working, direction calculation and quality of positioning have to be monitored, see table 3. 

If these parameters are not monitored, measurements can be inaccurate.

Table 3. Accuracy and quality of positioning

Accuracy / quality Description View on status bar

Direction calculation 
accuracy

When using a single antenna GNSS system, activate
direction calculation by rotating the machine at least 
90 degrees. Verify that background colour of heading
(D) is green

Quality of positioning Verify that the “RTK correction” is in FIX state, 
background of number of the satellites is green. 
See “Quality of positioning” 6.4

Note!
The manufacturer or dealer is not responsible for inaccurate or faulty measurements.
Check the accuracy of the system before starting work and frequently during the 
work  (see section 6.8 'GNSS accuracy test').
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4.1  License key and access rights for optional modules
Optional modules (features) can be enabled by ordering appropriate licence from retailer. License 
key is installed to the system at factory. License key (HASP) reserves one USB port from the 
system and shall not normally be removed.

4.2  Opening a project
Before using the system a project have to be opened.

Project can be imported to the system from USB-memory stick / FTP /   or using third party 
services like Infrakit. Select “Project” → Import from: (FTP / USB)

How to open a project:

1. Open project from the main view “Project → “Open Project Folder”. 

2. Select project from the list. 

3. Press “Read folder” to finalize selection.

• System start loading the project and will give estimation about remaining time.

• Opening a very large project and generating graphics may take few minutes to 
complete.
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4.3  Object selector (object selection method)
Objects such as points, lines, centerlines, surfaces and slopes can be selected from the display. 

Selection can be made

• Project → Read File (Lists all measurable objects: Line, Centerline, Point, Surface and 
Slope). (Fig. 37)

• “Longhold” Press display awhile from desired area (Lists only measurable objects from this 
area)

Autosnap: Measuring to a object (for example, line or point) when “autosnap” is selected (Fig. 38).

• Blue dot indicates which object or group is selected for measurement. 

◦ If group is selected, the nearest object from this group is taken for measurement.

Multiple objects can be selected at the same time:

• Line  : line objects that can be measured, for example, in pipe installation.

• Centerline  : line objects suitable for center-line. Center-line defines the station number and 
cross section.

• Point  : imported point objects, for example, in installation of manhole or light-pole standing.

• Surface  : surface model layers. When layer is selected all surfaces in that layer are visible. 
For example, used in a sub-grade of a pavement.

• Slope  : slope tab lists line objects that have known slope. Such lines exists in road lines. 
Line slope can be locked for measurement by selecting it in this tab. Note! Stringline model 
and module 4 (Road) is needed. 

Choose object and press “Select”. To exit without changes, press “Cancel”. 

You can unselect object(s) by pressing the blue dot:  

● “No line/surface/point/centerline selected for measure” 

Fig. 38. Object selector, autosnap
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Fig. 37. Object selector



4.4  User interface
User interface of the LandNova is shown in Fig 39 (“Terrain” tab is selected). View icons, 
“Information bar” and the “Sub bar” are described in this section. 

Fig. 39.  Main view of the LandNova with profile and cross view sections

(1) Drop down menu. Features are available from the drop down menu (see section 5.1 “Menu 
structure”)

(2) View icons and measuring point selection. Operator can change to another view by pressing 
the view icons. Select the most suitable view for the ongoing work. (See section 4.4.1)

(3) Main view. Zoom view in by (+), zoom view out by (-) 
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(4) Profile and cross-section.

Additional view is an optional (height can be adjusted). Possible additional views are: 

a) Side view only 

b) Front view only

c) Front view with side view

(5) Measurement (Terrain, Point, Line And DTM+Line) and information (GPS and Log) TABs

(6) Information bar (information depends about selected TAB)

(7) Sub bar
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4.4.1  How to change view or change active layer / line
View icons are located on the top of the screen (Fig. 41). Icons are normally hidden. Touching the 
screen brings icons into sight for few seconds (value can be changed from: Settings →  Installation
settings → User interface “Hide view controls with HUD”). 

Selected measurement point can be seen from the bucket icon (Fig. 40). The measurement point 
can be changed (toggled) by touching the bucket icon (Left / Center / Right / Automatic).

How to center the machine or a map:  Press “View icon” again.

Arrow icons

Icons Action

Change active layer 
Change active surface layer by pressing arrows 

Change active line 
Change line to next or previous line in the same group. Autosnap cannot be used 
with this function.
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Fig. 41. View icons Fig. 40. Bucket’s measurement point 



Map view

Select map view by pressing icon marked with green circle in Fig. 42.

View is from above of the machine. In this view the north is always at the top of the screen; project 
files remain orientated with north at the top of the screen regardless of changes in the direction of 
the machine. 

Panning of the map can be done by swipe action. Zoom controls '+ and -'  are available in all views
(highlighted by yellow circles in Fig. 42 and 43).

Fig. 42. Map view

Top view (icon is circled by green top view according to a machine Fig. 43)

In this view the machine is always static, boom is pointing to the top of the screen and the map 
rotates. 

Map can also be dragged (moved) by swipe action. Machine can be centered by pressing  “Top 
view” icon again. 

Fig. 43. Top view according to a machine
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Cabin view

Select the “cabin view” by pressing the icon (marked by the green circle in the Fig. 44)

Fig. 44. Cabin view

3D view

It is possible to view 3D map from a chosen direction by selecting 3D map by pressing the icon 
(marked by green circle in Fig. 45). The point of view can be changed with a swiping action, for 
example swiping left to right or up to down.

Fig. 45. 3D view
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Measurement point of the bucket

Select the measurement point which will be used for measurement, otherwise the
system may seem to give incorrect information. 

Pressing the measurement point icon toggles between

center → right →  left → automatic. The red triangle below the icon shows the measurement point.

When automatic measurement point is selected:

• The system selects the lowest point of the bucket blade as the measuring point.

• When the bucket blade is tilted less than 3 degrees, the system selects the centre point of 
the bucket blade as the measuring point.

Note!
Service technician can enable confirmation dialog to avoid unintended measuring 
point changes.
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4.4.2  Additional views, profile and cross-section
Additional views can be added onto the display (Fig. 48):

To add profile view, select:

• “Options” 

◦ “Profile / crossection”

• “Enabled” (Profile view(s) are visible / hidden)

• “Cut inactive layers” (Show all surfaces on the profile view)

• “Show zoom controls” (Zoom control icons are visible)

• “Cut lines / pipes” (Cut line and pipes are indicated with 'X')

• “Bucket angles” (angles of two axes are displayed in 
additional profile views)

• “Model Z” (Z value is shown)

• Breaklines for active DTM  

• Bucket arrow indicators  

To insert more information to the profile view, select:

• “Options”

◦ “Misc GUI items”

• “Model offset”. Height offset of model is shown. Change with double tapping the 
value on screen. (Fig 47)

• “Measuring point coordinates” (X, Y and Z coordinates of the bucket measuring 
point are shown on the screen Fig. 46) 

• Positioning on/off button  

• Line guidance indicator  

Fig. 48. Profile / crossection
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Fig. 46. Measuring point offsets

Fig. 47. “Model offset” value



4.4.2.1  Additional profile views detailed
Profile / front view (1) presents bucket from the front. Cross section / side view (2) 

Fig. 49. Profile / crossection detailed.

Orange arrows at Fig. 49  highlights the measurement line. Line starts from the measurement point
of the bucket and ends to an active surface.

Active (to be measured) surface is presented as bold solid line.

Possible views are following: (Tapping the profile view area toggles between different views)

(1) Bucket is shown from front (Fig. 49 )

(2) Bucket is shown from side (Fig. 49 )

(3) Combination of views 1 and 2. Bucket is shown from the front in left window and from side 
in right window (Fig 50)

(4) Cross section view (Fig 51. Center line measuring is needed, because cross-section view is
drawn by using that centerline) 

Symbols in optional profile and cross view section

Tilt of the bucket

Height (sea-level) of the selected surface.

Angle of the bucket

Icon in upper left corner indicates height of the measuring point compared to target level. The 
value indicates height difference between selected surface and buckets left corner (Fig 50). Icon 
and the value in the upper right corner indicates height difference between selected surface and  
buckets right corner.

Fig. 50. Profile view
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Fig. 51. Cross section view

Icon in the profile view.

Icon Description

The measuring point is at the target level

The measuring point is above the target level

The measuring point is below the target level

Tolerance can be changed from:

“Settings” → ”Installation settings” →  “User Interface” → “Accuracy tolerances / Height difference”.

4.4.3  Information bar
The information bar is divided to six different tabs for presenting relevant information about current 
work. Content of the information bar changes depending on which tab is selected.

Fig. 52. Information bar with Tab (Terrain is selected)
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4.4.3.1  Terrain 
Height difference to the selected surface and height of the sea-level are shown. Gives useful 
information when working with digital terrain models (DTM).

Fig. 53. Terrain tab

dZ height difference
Difference between a selected DTM and the measuring point of bucket.

Background colour in the “dZ” field indicates height offset of the measurement point.

Blue       Bucket is above the target level

Green    
At the target level within set tolerance. 

“Settings” → ”Installation settings” →  “User Interface” → “Accuracy tolerances / 
Height difference”.

Red        Bucket is below the target level

Z height (absolute height, height from the sea-level)

• Field indicates absolute height Z.

Number of satellites which are used to positioning with RTK correction.

• Shows the count of available satellites. The background colour indicates the state of the 
RTK correction. For best accuracy this must be in the FIX state (see Quality of positioning –
FIX, FLOAT and SPS states). 

• For some GNSS receivers GPS and GLONASS satellites are separated, for example “12 + 
6”. In that case the overall number of satellites is 18. 

• “As-built” data point is stored by pressing the satellite count panel (Fig.53, red circle). 

“As-built” points are always stored to the current layer. For example, if you are working with the 
DTM model and the model / layer name is the "Final surface" then all points are stored to the “Final
surface” layer. This can also be seen in the “as-built” data file when it is exported from the system.
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4.4.3.2  Point
From this tab a height, distance and direction to the selected point is shown with the sea-level 
height. Tab is also used for locating points.

How to select object: See section 4.3 “Object selector “

Fig. 54. Point tab is selected

dZ (height difference)
Shows the height difference between the selected point and the measuring point.

dL (distance, see the Fig 55)
Shows the distance between the selected point and the measuring point in boom line direction.

dS (distance, see the Fig 55)
Shows the distance between the selected point and the measuring point against boom line 
direction.

Fig. 55. dL and dS measurements explained

Z (Absolute height, height from the sea-level)
• Background colour indicates status of the heading:

◦ RED          Heading cannot be defined. (Accuracy is not sufficient).

◦ YELLOW  Heading has inaccuracy. (Accuracy is not sufficient).

◦ GREEN     Heading is defined. (Heading is as accurate as possible).
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4.4.3.3  Line
Tab shows height difference, distance and station number to the selected line. Used with the line 
models.

Fig. 56.  Line tab and information bar

dZ height difference
Shows the height difference from the measuring point to the selected line.

dS distance
Distance from the measuring point to the selected line object.

Fig. 57  Measuring point

Orange arrow points the circle that indicates the measuring point of the line. Name of the line is 
shown at the top of the point. Slope (%) is seen also.

dDir is “Line guidance indicator”, zero means that boom-line is parallel to selected line. This option 
can be activated: “Options” → “Misc GUI items” → “Line guidance indicator”.
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Fig. 58  Distance to the selected line.

P, Station number
Station number represents the distance which is measured from the start of a line model along 
the centre line. Distance can be defined to begin, for example, at 100 metres. When undefined,
“P” displays the distance in metres from beginning of the line. 

Satellite count (here are 7 active satellites. Marked with red circle in Fig. 56)
The background colour of the field indicates the state of the RTK correction. State have to be 
“FIX” (field is green) for most accurate work. More information about accuracy is in section 
“GNSS accuracy test”. 

• Satellite panel tapping stores the point (as-built data) to the selected surface.

“As-built” points are always stored to current layer. For example, if you are working with DTM 
model and the model / layer name is "Final surface" then all points are store to “Final surface” 
layer. This can also be seen in the “as-built” data file when it is exported from the system.
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4.4.3.4  DTM + Line
Combination of the “Terrain” and the “Line” information. Height deviation to the selected surface 
and height deviation and distance to the selected line is seen.

Select surface and line from “Project” → “Read File”.

Fig. 59. DTM+Line

Information on the display:

• dZ – Height deviation from the selected surface (red background warning “too deep 
cutting”)

• dZl – Height deviation from the selected line

• dSl - Distance from the measuring point to the selected line.  

• Satellites – Count of satellites /  “As-built” data store button

▪ Allows to see measurement results (model and line) simultaneously. On road 
construction worksite the “As-built” data is collected and stored from breakline 
points. In that way a driver does not have to change between the line and DTM 
views. “As-built” data can also be stored by pressing the “satellite count number”.

“As-built” points are always stored to current layer. For example, if you are working with DTM 
model and the selected surface name is "Final surface" then all points are store to “Final surface” 
layer. This can also be seen in the “as-built” data file when it is exported from the system.

4.4.3.5  GPS
Shows the status of the positioning device. Information may vary with different receivers. 
Background colour has the same meaning as background colour of the “satellite count” field. 

HDop value represents positioning quality (receiver calculates the estimate), the lower value is, the
better is positioning status. The default HDop value is 1.5 (above 1.5 the background colour 
changes to yellow which indicates poor accuracy).

HDop value can be changed by technical support personnel/technician.

See section 6.4 Quality of positioning for details.

Fig. 60. GPS tab
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4.4.3.6  Log 
Tab is used for changing the code of the stored log point. Log tab is also used for saving log points.

Fig. 61. Log tab

Save pos: (1...∞), green rectangle highlights the running number of a stored point.

• Button saves the position with a selected code. Code is shown in the ”Code” button 
(marked with green circle). 

• If position can't be determined accurately the application shows the dialog ”Bad accuracy, 
are you sure?”

Enter point (Points can also be entered manually to the system.)

When pressing the ”Enter point” button coordinate input dialogue appears.

• Coordinates:

◦ X, Y and Z can be entered manually

◦ “Get from the receiver”

◦ “Measuring point using A(L), B(S) and dZ” (operator enter the data)

• Finally press “Save point”.

• Press “Close” to exit dialog.

• Point is named (coded) by selected / entered code.

Coordinates can be entered manually or can be taken from the positioning device. Positioning 
device coordinates (positioning antenna) are read by pressing the ”Get from the Receiver”. Point is
stored with current code by pressing ”Save point”.

Enter Code / Name (Fig 61 green circle)
Saved points can be categorized by using different codes. Codes to be used are usually 
determined by the surveyor (of the job site). The proper code can be entered by pressing the 
button. 

• When button is pressed the “feature code list”-dialog opens and code can be entered, or 
code can be selected from list (codelist has to be imported).

◦ Default Codelist can be taken in use: “Settings” → “Installation settings” → “FCL”: 
select proper codelist and press “Import”. Codelist can be included in the project by 
adding codelist file to project root.

• Last used code is shown in the button.

Point name (description)

• Button can be used for giving additional personal notes when storing points.

• This additional name is given just once with the next point. 

• Information is used only for the operator
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Coordinates (Fig. 62)
Values X, Y and Z on the bottom of screen are the coordinates of the point to be saved. The 
background colour of the field indicates the status of positioning system.

For detailed information see section 6.4 “Quality of positioning”  FIX, FLOAT and SPS states.

Fig. 62. Coordinates

Background colour in the “Coordinates” field (Fig 62) indicates measurement accuracy.

Background 
colour / state

Description

FIX Accuracy is approximately ±3 cm (X, Y and Z)

Float One or more components of the RTK correction is insufficient. Accuracy is most 
of the time better than one meter.

SPS The RTK correction cannot be used (standard GPS accuracy is few metres)

Codelist
Codes are used to identify objects such as lightpoles, pipes and points (Fig 63). Numeric codes in 
the left column are translated to text form (at the right column).  

Fig. 63. Feature Codelist

Open the Codelist by selecting: “Settings” → “Installation settings” → “FCL”, and press close

If needed code is not available in the list: 

• Code can be entered (inserted) manually 

• It is also possible to import pre-defined codelists for measuring purposes.

◦ Import codelist: Select “Settings” → “Installation settings” → “FCL” → “Import”

You can select proper code from the code list (Fig. 63). Dialog opens when pressing code button 
(Fig. 64 green circle). 

If needed code is missing from the list, the code can be entered manually on the codelist dialog 
and its used next time when point is stored.

Fig. 64. Select proper code for object. 
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5  MENU

5.1  Menu structure
Main menu structure of the LandNova 3D application. Some features are limited to be used by 
support personnel.

Project 
• Open Project Folder  

◦ Select project for the jobsite. 

• Read File   
◦ Line, Centerline, Point, Surface and Slope can be selected.

• Import from FTP  

◦ Import Project from FTP server

• Import from USB  

◦ Import Project from USB memory stick

• Export Collected Points  
◦ Logged objects are exported to Project or to USB memory stick or by FTP upload

• Undo last log point  
◦ Last log point is deleted

• Project changelog  

◦ Project changelog can be used to synchronize projects either from the Xsite Office or 
from the Infrakit.

◦ Project changelog shows all the changes that are made by the worksite staff (for 
example, Surveyors, site managers).

• About   
◦ Information about application, software licenses and currently loaded project

• Exit   
◦ Leave 3D application and return to the 2D “Vision” application. 
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5.2  Options menu

Options
• Terrain type    

◦ Select appearance of a terrain model / surface: Hidden, Wireframe, Wireframe & fill 
50% transparency, Wireframe & fill 80% transparency , Filled 50% transparency, Filled 
80% transparency.

• Point Size   
◦ Size of points in the display: Small, Normal, Huge

• Active point attributes   
◦ Group, Position, Sequence number, Code, Description, Navigation arrow

• Machine visibility   
◦ Appearance of machine: Solid, Transparent 30%, Transparent 70%, Hidden

• Machine parts   
◦ Select visibility of parts of the machine, Bucket, Boom, Chassis, Bucket Axes

• Profile / crosssection   
◦ Appearance: Enabled, Cut inactive layers, Show zoom controls, Cut lines / pipes, 

Bucket angles, Model Z, Breaklines for active DTM, Bucket arrow indicators

• Misc GUI items   
◦ Model offset, Measuring point coordinates, 

◦ Positioning button ON / OFF  (button is visible or hidden)

◦ Line guidance indicator

• Logging  

◦ Require shift height: System asks  “height shift” value when storing points

• Window Settings   
◦ Restore defaults: Default settings are restored

• Color Settings   (change colour and visibility)
◦ LandNova adjusts the layer colours automatically. If you are not satisfied with 

LandNova's preferences, it is possible to change colours. Select  “Options” → “Color 
settings”

◦ LandNova is using colours from files and layers if possible (For example DXF files 
include colour support but XML don't).

◦ If colours can not be used from files/layers, then LandNova is adjusting colours 
automatically.

◦ Menu can also be used for file/layer visibility, by using the light bulb icons on the left 
side.
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Colour settings detailed:

 File/layer is used as an background map

 File/layer is always visible, even when layer is not selected

File/layer is always invisible, even if layer is selected

File/Layer is only visible when layer is selected

Note!
It is recommended to have surfaces in automatic mode, Lines and Points always as 
visible. Background maps as visible when needed.

5.3  Settings

Settings
• Coordinate System  

◦ Load coordinate transformation, Edit coordinate offsets, Load geoid model

• GPS control  

◦ Novatron GNSS, RTK corrections

• Installation settings  

◦ Various settings: Positioning, Machine Control, Measures, File import, Data log, 
Language, FCL, User Interface, LibConverter config

• Show Antenna   (For service personnel only)

• Show status  
◦ Status of GPS and COM ports, Geoid Model, global coordinate system

• Open ini file   (For service personnel only)
• Flat bucket calibration  

◦ In general, a flat bucket is used for levelling a surface. After performing a flat bucket 
calibration the buckets bottom real angle can be seen on the display. Calibration also 
changes the graphical view to match the real position of the flat bucket. 

◦ How to calibrate flat bucket:
▪ Select  “Settings” → “Flat bucket calibration”.
▪ Move the bucket to the horizontal plane. 
▪ When the bucket is aligned, press OK.

• Tool Settings   (only graphical, not affecting to any measurements)
◦ Select tool, for example, a different bucket 
◦ Enter or change dimensions of the bucket which is used.
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5.3.1  User interface
Select:

Settings → “Installation settings” → “user Interface”

Accuracy tolerances (Green level)

• Height difference: Surface, Point and line dZ and
DTM+Line dSl "Green level" tolerance

• Sideway difference: DTM+Line dSl, Line dS and
Point dS/dL "Green level" tolerances

Profile view maximum zoom vs. bucket width (selecting
100% → the bucket fills whole screen)

Profile viewer height → select suitable height for the profile
view (60px...350px, 200px is the default)

Point autosnap settings: Mode

• 3D autosnap: Closest object in autosnap mode is calculated in XYZ

• 2D autosnap: Closest object in autosnap mode is calculated in XY

• Active point switch threshold: How many percent closer a new object needs to be before 
autosnap function is changing to nearest object (0% is the default)

Installation settings →  File import →  Drawing distance

Setting the Drawing distance (10 metres to 10 kilometres) affects how far from the measurement 
point the map is drawn. Smaller value gives better performance (map will be updated faster on the 
display). 

5.4  Operations

Operations
• Create reference line   (See section 5.4.1)

• Accuracy control:   Optional feature, contact support for detailed information. 

◦ (Compare measurement point to the known reference point. Can be activated by a 
service personnel.)

• Drilling plan creator  :  (See section 5.4.2)
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5.4.1  Create reference line
Select “Operations” → “Create reference line”

Reference line creation is used to form simple models of the terrain between two points. It is  
useful in situations where the actual terrain model is not available. It can be used, for example, 
foundations of buildings.

Reference line creation:

1. Define two points (there is three different ways to define these points)

• Press “List” and select points

• Or enter coordinates for the points(X, Y and Z)

• Or choose the points from the work site view selecting “Pick”

• Slope, distance and heading: 

◦ You can modify reference line slope, distance and heading by using buttons.         

Note! Point2 coordinates are modified automatically so that desired 

slope/distance/heading is achieved. Point1 coordinates are fixed. 

2. Optional: Name the surface (If an automatic naming is improper)

• Click the name and edit.

• Surfaces with the same name are combined to same surface automatically.

3. Profile

• Define values for a model cross section which are used during in the terrain model creation.
You can leave some fields empty. Values are inserted in metres. (Blue arrow points to the 
center-line)

4. Generate

• The system creates a model to the active project folder.

•  Note: The blue arrow in the picture shows the center-line, “0”. Point1 is closer to operator
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5.4.2  Drilling plan creator
With creator you can define field by entering the number of rows
and columns. 

How to create “Drilling plan”

1. Select “Operations” →   “Drilling plan creator”

2. Enter:

a) Row count

b) Column count

c) Row spacing (in metres)

d) Column spacing (in metres)

3. Place bucket's measurement point to the starting point (1)
of the field and press   Start Point   

4. Place bucket's measurement point to the direction point (2)
of the field and press    Direction Point   

5. Press   Generate   to create field with rows and columns

a) Note: Generating field takes few seconds

Fig. 67 Completed “Drilling Plan”
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5.4.3  Importing project data to the system
With the LandNova, an operator can start work by opening the appropriate project. Import the 
project folder with all of its files and sub folders into the system. 

For experienced operator:

Verify the project files by checking them at your desktop version of LandNova. Find the existing 
folder named “road” and create a sub folder there. Name of the sub folder should be descriptive
(consider using the name or the stage of the project).

Control keys for desktop Landnova:

• A, D: Rotate machine on the map

• W, S: Drive machine on the map.

• R, F: Up / Down (Z axis, height)

• Keeping the “Shift” pressed with (W, S, A, D) the movement is faster (maximum speed)

Copy project files to the sub folder just created. Open the folder using the LandNova software: 
Select “Project” → “Open Project Folder”. 

Verify that all files can be seen and are usable. If you are missing project files in the view, check 
the coordinate system of the file with your CAD system

Files can be imported from 

• A network server (FTP) 
• A memory stick (USB).

 User Manual. Xsite PRO SPI 14.2  Page 56 / 77



5.4.4  Importing the project from FTP
You can request FTP account from your local dealer or use your own FTP server. 

Server settings are entered from “Settings” →  “Installation settings” →  “Data log”. 

Enter:

• Server address

• Username

• Password

• Machine ID: Do not use the default ”MyExcavator”

Importing from FTP:

1. From the main view, choose “Project” → “Import from FTP”. This opens a new window.

2. Project folders on the server are displayed in the column. When a project is selected its 
contents are displayed.

3. When contents of the folder are visible select ”Import”.

4. The loading status is shown on the screen. 

5. After a successful download the project is automatically taken in use.

5.4.5  Importing the project from USB memory stick

Note!
Note that all the files need to be in a folder on USB memory stick. Folder name is 
going be the project name

When using a USB memory stick, the memory stick should be scanned for viruses / malware 
before being used in the system.

Importing project from USB:

1. Insert a memory stick to the USB port (on the display unit)

2. In the main menu, choose ”Project” → ”Import from USB”.

3. Choose the appropriate project (folder) from the list.

4. Press “Import”.

5. The project folder and files are copied to the system. Once copied, the project folder can be
accessed in “Project” → “Open folder”.
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5.5  Example projects

5.5.1  Digital terrain models
Description:

Digital terrain model (DTM) is a common convention to represent the height and location of the job 
site. DTM should be in Triangulated Irregular Network (TIN) format. Terms such as triangulated 
model, terrain model or surface are often used as synonyms for DTM. DTM is easy to read and 
don't require much interpretation of the target.

Troubleshooting:
Depending on the CAD software some errors may happen in the triangulation process of the DTM. 
These errors may show up as holes or flawed slopes in the model. Such defects have to be fixed in
the CAD software before transferring DTM to the LandNova.

Different formats:
DTM/TIN can be imported to the LandNova in DXF or LandXML format. In DXF format it is crucial 
to export 3DFACE objects from CAD. In LandXML format DTM/TIN should be a surface object.

How different layers are shown on the display:
Multiple files in DXF or LandXML format can be imported to single project folder, which allows the 
so-called layer management. Each layer can be given a descriptive name and a distinct colour. 
The visibility of each layer can also be adjusted from the Main view “Options” →  “Color settings”.

Note!

The naming of the surface model should be done so that it is easy to understand, 
because the operator sees models by name.
  - DXF: name of the layer is shown
  - LandXML: name of the surface(s) / element is shown

Note!

Compatibility mode which supports SPI 13.5 “file name defines surface” is available.

To enable “SPI 13.5 compatibility mode”  tick “Settings” → “Installation settings” →
“LibConverter config” → “File is single layer” 

“File is single layer” mode forces file name to be used as a
layer name regardless of the layer or surface original name.
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5.5.1.1  Background maps in projects

When using projects with background map, you can add “!BG” to the file name.
When !BG is added to file name, drawing limit is not effecting to it. 

Background maps can be used with  DXF and LandXML files. When “!BG” is added to the file 
name, all measuring functions are disabled and handling of the background map is much faster. 

For example, rename file ”City_base_map.dxf” to ”City_base_map!BG.dxf”. 

Example of a background map is shown in Fig. 68.

Fig. 68 Background map in project
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5.5.1.2  Line model 
The line model is an effective tool when tracking long continuous targets such as pipelines, road 
lines or trenches. When line model is used the system can display height difference, station 
number and side measurement against the line model. 

With these features the model can be applied to describe variable targets, due height remains the 
same in the target, even when the position is changed.

Lines can be imported in DXF, LandXML, PXY, GT, and KOF formats

As an example, some practical methods for illustrating pipe grooves are:

• Preparing geometry lines for pipes
• Using different colours and descriptive naming to separate lines

Both functions above the measurement tab's are the same:

dZ Height difference between the bucket's measuring point and the selected line

dS Sideways distance from the measuring point on the selected line

P Station number, which in this case is calculated from beginning point of the line. Distance 
can be defined to begin, for example, at 500 metres. When undefined it displays the 
distance in metres from beginning of the line. (Fig 69)

Fig. 69 Station number

A is the starting point of the line and the B is the point on the line that is nearest to the bucket 
measuring point. The station number is the distance between A and B along the line
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5.5.1.3  2D / 3D object proximity alarm
When using the “proximity alarm”, the system gives warning when measurement point of the 
bucket is closer to object than pre-defined value. Object is a line or a point. 

The proximity alarm can be used with 
• LandXML 
• DXF 

Take proximity alarm to use by adding “!W=X” to a file name, “X” stands for a warning distance 
given in centimetres.  

Example of the proximity alarm of one meter (100 cm): 

Rename file “Road_one.xml” to “Road_one!W=100.xml”. 

The system gives warning with 2D or 3D objects just depending on the Z coordinate of the object.

If the Z coordinate is zero then the functionality is automatically in 2D mode.

With 3D objects the alarm can be used for avoiding damaging existing pipes or cables, for 
example.   

Fig. 70 displays a 3D warning level when working near an existing heating network. Warning level 
is set to 100 (equals 100 centimetres). 

NOTE! In reality, as small as one metre warning level should not be used due possible damage 

for cables or pipelines. Needed warning distance depends on numerous things (accuracy of the 
map, is cable still at place where it was placed, and so on)   
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5.5.2  Additional files for digital terrain models and line models
More value can be added to projects with digital terrain models or line models by adding 
informational elements, such as text labels and background maps, into the project folder.

5.5.2.1  Point files
Point files are useful for representing the position of a simple object, for example, a well or a lamp 
post. Points can be imported as DXF, LandXML, PXY, GT, and KOF formats. When importing 
points, coding can be used to differentiate points from each other. For example, the number of the 
well can be attached to the code property. 

A single point can be activated for point measurement. Point measurement mode is described in 
section 4.4.3.2 'Point'

Note!  DXF points do not support the “point code” property.
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6  ACCURACY TEST
The accuracy of the system should always be checked before starting work. Following procedures 
provide an easy way to ensure the accuracy of the system.

Close “LandNova” (Project → Exit) and continue with the “Vision” to perform tests.

Note!
During the tests, all machine parts (bucket, stick, boom) should move to get most 
reliable measurement results.

6.1  Depth and distance accuracy test 1

Accuracy test 1

1. Place the bucket on a reference point and zero the measurement value.

2. Turn the bucket (without tilting it sideways) to a different position and place it on the same 
point.

3. The height and lengthwise distance readings should be close to zero in every position (an 
accuracy tolerance of  ±1 cm is allowed).

Bucket accuracy test 1

6.2  Depth and distance accuracy test 2

Accuracy test 2

1. Place the bucket on the ground and zero the measurement reading.

2. Move the bucket and use a tape measure to measure the height and lengthwise distance 
difference between the bucket measuring point and the starting point.

3. The system should indicate the same readings (an accuracy tolerance of ±1 cm is allowed).

Bucket accuracy test 2
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6.3  Tilting bucket accuracy test

When using the tilt function, test the accuracy of the bucket edges.

1. Straighten the tilt rotator (if the machine is equipped with one)

2. Switch the measuring point to “Center” 

3. Set the bucket blade on a horizontal level and move the centre of the bucket to the 
reference point. Zero the measurement readings

4. Tilt the bucket and put the left corner on the reference point 

5. Height and lengthwise distance readings should be as close to “0.00” as possible in every 
position

6. Repeat this accuracy test with the other corner of the bucket

7. If the accuracy is off by more than ±2 cm recalibrate the bucket. See section 3.10.2 “Tilt 
bucket calibration”. 

Tilt bucket accuracy test
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6.4  Quality of positioning
The system determines its position accurately by using RTK correction, which is based on a 
satellite navigation method. System applies positional corrections using a base station. 

Table 4 lists things that have an influence on the quality and accuracy of the GNSS positioning. 
The RTK positioning state is described in table 5. 

Table 4. Positioning quality (accuracy)

Positioning quality 
depends on

Description

Number of satellites More satellites lead to better accuracy. RTK initialization demands 
that at least 5 common satellites must be tracked at base and rover 
sites. Once initialization has been gained, a minimum of 4 
continuously tracked satellites must be maintained to produce an 
RTK solution.

Satellite geometry (Fig 72) Satellite geometry describes the position of the satellites from the 
view of the observer. Positioning is more accurate if satellites are 
widely and evenly spaced throughout the sky.

Baseline Increasing the distance between the machine and the base station 
weakens positioning accuracy

Location of base station Machine and base station must have access to the same satellites

Communication between 
machine and base station

Weak radio link or network may cause latency in data transmission

Fig. 72  Satellite geometry. 

Satellite geometry:

1. Good geometry

2. Poor geometry (accuracy is not best possible)

Table 5. State of RTK correction

RTK state Description

FIX RTK correction is used. Accuracy is best possible

Float One or more components of the RTK correction is insufficient. Accuracy is most of 
the time better than one meter. 

NOTE!  Accuracy is insufficient to be used with LandNova.

SPS The RTK correction is not available. Standard GPS accuracy is used instead

NOTE! Accuracy is insufficient to be used with LandNova.
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Operator should monitor that the RTK correction is in the FIX state. The background of the reading 
at the right bottom corner is green when the RTK receiver is in the FIX state (Fig. 73)  Background 
area is highlighted by white rectangle.

Fig. 75. FIX: The background of available satellites and sea-level indicators are yellow, accuracy is not 
acceptable (HDop value is outside a predefined value)
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calculation is activated.

Fig. 74. Float or SPS: The background of sea-level indicator is red. Direction calculation is not activated.



6.5  GNSS positioning, RTK correction and localisation
An explanation the basics of GNSS positioning, coordinate systems, and Geoid models and 
positioning quality.

RTK correction

3D machine control applications for excavators are typically based on Real Time Kinematic (RTK) 
GNSS technology. Centimetre-level positioning accuracy can be achieved by using a base station 
that provides a correction data to the machine. A correction signal is transferred to the machine by 
radio or wireless Internet connection 

UHF Radio

The operating radius of a base station that is equipped with a UHF radio transmitter can be up to 5 
km. The operating radius depends on transmission power, antenna type, antenna cables and a 
landscape (trees, buildings and hills can block correction data). Check for your local policy for radio
equipment.

The Internet

When using the Internet for streaming the correction data, the operating radius of a base station 
can be extended up to 30 km. However, the longer the distance between the machine and the 
base station, the poorer the positioning accuracy. Increasing the distance by one kilometre 
weakens the positioning accuracy by approximately 1 mm vertically and 0.5 mm horizontally.

The reference station can be a single base station or a base station network (a base station 
network consists of several base stations). Connection to a base station network is established by 
wireless Internet. Depending on the type of network, the correction data can be received from a 
single base station, for example the one that is closest to the jobsite, or data from several base 
stations can be used to calculate a virtual reference station. The availability of base station 
networks varies by country and area.
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6.6  Coordinate systems and transformations
GNSS systems use a WGS84 coordinate system for
positioning. WGS84 is a geodetic coordinate system
where a position is specified as latitude, longitude,
and altitude. Latitude is expressed as an angle from
the equator (Fig. 76). Longitude is expressed as an
angle from the prime meridian (Greenwich meridian).
Altitude is height compared to the WGS84 reference
ellipsoid (Fig. 77). An ellipsoid can be seen as a
simplified presentation of the surface of the Earth.

Project files, for example Digital Terrain Models
(DTM), use Cartesian coordinate systems. This
means that a transformation from a geodetic system
to a Cartesian system has to be carried out. When
transforming geodetic coordinates to Cartesian
coordinates, geodetic coordinates are projected from
an ellipsoid onto a plane.

A Cartesian coordinate system specifies a position by
using metric units instead of angles. The coordinates that specify a point on a plane are typically 
called northing and easting (Fig. 76), or X and Y. The Cartesian X, Y, and Z coordinates in the 
system are the result of coordinate transformation, offset parameters, and the Geoid Model that 
has been selected.

Note!

Using the correct coordinate system is very important when working with tasks 
(project files) that have absolute coordinates. When working with tasks without 
absolute coordinates (for example if only the height offset to a stake has been 
defined), any coordinate system that is suitable for the working area can be used.

There are two ways to carry out coordinate transformations.

1. Use national or regional coordinate systems.

2. Create a local coordinate system for each jobsite

Fig. 77. Geoid Model
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Fig. 76. Geodetic coordinates



6.7  Geoid Model
The site to be used for the height of the system shall normally be based on the findings made with 
respect to the Earth's surface gravity. The gravitational field isn’t everywhere the same, because 
the planet's density varies depending on the mountains, deep seas and other forms depending on 
the surface.

Differences in the height of the ellipsoidal system can be corrected by using the Geoid Model (Fig.
77). Geoid Model is a “net” which contains the needed correction data.

If the height difference between the Geoid and ellipsoid is significant, height of the ellipsoid needs 
to be corrected. If Geoid Model is not available, the height of the ellipsoid can be corrected by 
using a coordinate offset values.

6.8  GNSS accuracy test
When using the GNSS positioning, it is recommended to check its accuracy daily.  

A known fixed checkpoint is required for the accuracy check. If there is no surveyor available to 
measure the fixed point, the measurement can be done by using the GNSS receiver of the 
machine.

Note!
If the checkpoint is measured with the GNSS receiver of the machine, only 
calibration of the machine can be verified. A checkpoint measured by a surveyor is 
needed for verification of the coordinate system.

The way to check accuracy is to enter the known coordinates of the checkpoint into the 
system. 

1. Enter the known X, Y, and Z coordinates of the checkpoint into the system using “Log” tab

2. Select point tab

3. Choose the point that has been created

4. If there is single GNSS receiver, rotate the machine 360 degrees

5. Confirm that the system has an accurate RTK FIX status (when the background colour of 

the status bar is green )

6. Place the bucket on the checkpoint

7. Confirm that the correct bucket measuring point is selected

8. The “Height deviation”, “Sideways distance”, and “Lengthwise distance” values on the point 
tab should be close to zero. Typically the deviation should be no more than 2 cm vertically 
and 3 cm horizontally (however, the accuracy required depends on the type of work and 
type of machine)

9. If the accuracy is not satisfactory, check the calibration of the bucket and the machine. Also 
see section 6.4 “Quality of positioning”.
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7  NETWORK OPERATION

Note! SIM card is needed when network services are used.

Xsite PRO system has a built-in modem, which enables the use
of network features when a SIM card is installed in to the MCC15
computer unit. See installation of SIM card from section 2.3
“Getting started”

Some of the features can be used through the quick menu of the
system. The menu can be accessed by pushing both brightness
buttons on the display unit simultaneously. “Headset” Icon will
appear on the screen and double tapping it will open PCBg
menu. “Request help” and “Web links” buttons are discussed in
following section “Remote support“ (Fig. 78).

7.1  Remote support
If you need guidance the remote support connection allow
technical support to give assistance. Remember to call your local
support. Press both brightness buttons from the display unit
simultaneously then remote connection opens and “Headset”
icon appear on the screen. Double clicking the “Headset” icon
and selecting “Cancel help request” will close the connection.

Closing the menu does not disconnect the remote connection. 

If remote support has been allowed then a support person can offer help without a request. When 
support is offered the window “Remote assistance available” appears. By clicking “Yes”, the remote
connection is opened.

Button label Status of the connection        icon When button is pressed  

Request help Connection is closed.
Help is requested and finally 
connection is opened.

Requesting help...
Connection is being prepared 
and should be available in a 
few seconds.

No action.

Cancel help 
request

Support person is currently 
using the remote connection.

Connection is closed.

Icon Description

Support person is online.

Connection is available for support.

Connection is prepared. If icon stays red then connection cannot be established.
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8  TECHNICAL SPECIFICATIONS
MCC15 computer unit

Processor AMD GX-411GA / 1.1 GHz Quad core

RAM 2 GB

Operating system Windows Embedded Standard

Wireless communication GSM / GPRS / EDGE / WCDMA / UMTS / HSPA / HSUPA / LTE

Data transfer rates Download 100 Mbps (max), upload 50 Mbps (max)

Input voltage 10 to 36 VDC 

Power consumption 10 W 

IP classification IP20 

Operating temperature -20 to +50 °C

Dimensions 250 x 160 x 90 mm

Weight 2.5 kg

Connections CAN, CAN (XD2 LED display), Display (Xsite Pro), 3x USB 2.0, 
5x RS232, 2x GSM antenna, SIM, CFast, DisplayPort, Ethernet, PWR

Xsite Pro display

Display type Transflective TFT LCD

Touch screen type Capacitive

Size 8.4”

Resolution 600 x 800 pixels (SVGA)

Luminance 800 cd/m2

Contrast 900:1

Power consumption 5 W

IP classification IP33

Operating temperature -20 to +60 °C

Dimensions 263 x 237 x 65 mm without RAM mount

Weight 1.7 kg
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G2 Sensor

Measuring axis X, Y, Z (three-axis)

Power consumption 2.5 W when the heating is on. 1 W without heating

IP classification IP67

Operating temperature -40 to +85 °C

Dimensions 98  x 41 x 33 mm

I/O CAN

EL2 laser receiver

Receiving angle 150°

Receiving area 150 mm

Resolution 1 mm (precision is 5 mm)

Operating voltage 10 to 36 VDC

Power consumption 2.5 W

IP classification IP67

Operating temperature -20 to +60 °C

Dimensions 315 x 96 x 55 mm

Weight 0.7 kg

I/O CAN, RS-232

Compatible lasers All rotating  lasers with visible or infra-red light: wavelength 600-
800nm, rotating speed 120-1200 revolutions per minute.

XD2 LED display

LED type RGB

Number of LEDs 50 pcs

Operating voltage 10 to 36 VDC

Power consumption ~ 2 W typically

IP classification IP43

Operating temperature -20 to +50 °C

Dimensions 120 x 60 x 25 mm without RAM mount

Weight 130 g

I/O 2 x CAN
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